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Inspecting and Fixing a Word Document: 

WHAT ISSUES OF A DOCUMENT NEED CHANGES TO MAKE IT COMPLIANT TO ALL USERS? FINDING 
AND FIXING THE ISSUES IN A WORD DOCUMENT BY USING BOTH THE ACCESSIBILITY CHECKLIST AND 
THE INSTRUCTIONS IN THIS GUIDE WILL HELP RESOLVE MOST ISSUES CAUSING THE DOCUMENT TO BE 
NON-COMPLIANT. CREATING AN ACCESSIBLE DOCUMENT BENEFITS ALL USERS. 

Adding a Document Title to the Document 
Creating a Title to a Document. 
Documents should have titles that describe their function or purpose of the document. It is usually the 
first content that is announced by screen readers instead of the file name. To give a title to a 
document complete the following steps: 

1. Go to the top left of the document. Click on “File” tab.

2. After clicking on the File tab, Microsoft Office Backstage view will appear. Find the “Info”
button to open the Document Properties window.

3. To the right of the Info button is where the Info section is. Further right of the Info section find
where it says “Properties.”

4. Below where it says Properties find where it says Title.

5. To the right of Title select where it says, “Add a title” click on it and an input box will appear.

1. 

2.
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6. Write the document’s title it can be the same or different from the filename. This document 
title’s is “Non-Compliant Doc.” 

7. Now the document has a title for the screen reader to read. 

Using Check Accessibility Tool and Fixing Issues  
It crucial to ensure that documents are accessible to people with disabilities. Checking and fixing 
accessibility issues in documents promotes inclusivity compliance with accessibility standards and 
grants equal access of information to users. It improves readability, usability, and navigation, 
benefiting all users. It will enhance user experience and facilitates understanding of content, 
fostering inclusivity, diversity, and equal opportunities for all to obtain information. 

How to find and use the “Check Accessibility” tool. 
The “Check Accessibility” is a tool that performs a full and thorough check for whether the document 
conforms to accessibility standards. It finds any issues such as the missing use of alternative text on 
images, presence of complex tables, missing document language, and hard-to read fonts’ colors to be 
corrected. By following these steps, it’ll enable the checker to identify and address the accessibility 
issues in the document: 
Finding the Accessibility Checker 

1. Go to the top left of the document. Click on “File” tab. 

 
2. After clicking on the File tab, you can see Microsoft Office Backstage view. Find the “Info” button 

to open the Document Properties window. 

1 
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3. To the right of the Info button is where the Info section is. Where the document's properties are 
to specify or modify the document’s information 

 

1) In the Info section find then select the “Check for Issues” dropdown 
button.   

2) In the Check for Issues drop-down select the “Check Accessibility” 
option.  This will open “Accessibility Inspection Results.” 

2 

3. 
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3) The “Accessibility Inspection Results” box will now appear on the 
right of the document. 

4) In the “Inspection Results” it’ll show the issues making the 
document non-compliant. Select an issue to work on. 

 

* Keep accessibility checker running while working on document. To see if there are any 
issues that could be created by fixing document or making mistakes while fixing it. * 

1 
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Another Way to get to the Accessibility Checker 
1. Go to the “Review Tab.”

2. In the Review tab find the Check Accessibility button then click on it.
A drop-down with options on what to check for in the document will
appear.

3. Select the Check Accessibility option.

4. Now you will see the “Accessibility Inspection Results” box to the right of 
the document.

Some Accessibility Issues to Cover 
Some of the issues that we will be covering are: 

• Missing Object Description: Missing alternative text on an image.

• Use of Merged or Spilt Cells: Creation of a complex table.

• Hard-to-Read Text Contrast: Light or faint contrast between text and document
background.

These are the most common issues to be found in a Word document. Going over these common 
issues in this guide by inspecting and fixing the errors so that the document can become compliant. 

Fixing Accessibility Issue: Missing Object Description 
Missing Object Description is crucial for individuals who are blind or visually impaired, as screen 
readers rely on alternative text, also known as alt text, to convey the meaning of images. Alt text 
allows these users to understand the context and purpose of the images making the document more 
accessible and inclusive. Additionally, alt text is useful in situations where the image cannot be 
displayed due to technical issues or when the document is being accessed by devices with limited 
visual capabilities. By providing accurate and descriptive alt text, it ensures that the document can be 
understood by a wider range of users. 

Giving Alternative Text to Images, Pictures, and Clip Art. 
It helps screen and document reading tools describe images to visually impaired readers. Giving 
alternative text when an image, picture or clip art does not have one or has a generated crated one 
can be done in a few steps:  There are two ways to give an images alternative text. 

2 
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First Way to Give an Image Alternative Text. 
1. Right click on the image.
2. Select “View Alt Text” Option.

3. The “Alt Text” box will appear to the right of the document.
4. In the input text box give a description of the image. In this case write “Great Seal of

Nevada” to describe the image.

*If an image is of no importance such as it being decorative or line(s) to divide page or
repeating logos/images that does not need to be read, then it can be marked as
decorative instead. This will cause the screen reader to overlook the image. *

1 
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5. Below the input text box where the description of the image is given. Select the check
box called “Mark as decorative” to checkmark it.

Now the image will no longer be read or will need alternative text. 

6. The rest of Alt Text box will be greyed out/inaccessible to use after check marking the
Mark as decorative check box.

Second Way to Give Alternative Text to an Image 
By using the Accessibility Inspection Results box to the right of the document.

2. Go  to the Accessibility Inspection Results.
3. Select the error Missing Object Description. It’ll open the specific cause(s) of the error.
4. Select the issue called “Picture1”. It’ll make the “Recommended Actions” to appear 

and give different options to correct the error.
5. The correct one for an image to be read is to select the “Add a description” option.

6. “Alt Text” box will appear to the right of the document.
7. In the input text box give a description of the image. In this case write “Great Seal of

Nevada” to describe the image.
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8. If image is of no importance to the document, then mark it as decorative. Follow the
previous steps 1-3, then select the “Mark as decorative” option this time.

Now that all the images have been given alternative text or marked as decorative the Missing 
Object Description error in the Accessibility Inspection Results box will disappear. As there are no 
more of this kind of error that needs to be fixed.  

Fixing Accessibility Issue: Use of Merge or Spilt Cells 
Removing Merged or Spilt Cells from Tables. 

Merged and Spilt cells should not be used in a table. This is because that can cause confusion to the 
reading order making the information in the table difficult for screen and document readers to follow. 
People using screen readers will read one cell at a time and expect one row or column header for each 
cell in the table so that it doesn’t lose content. Follow these steps to create a simple table structure 
for data only. There are two ways to correct this problem: 

First Option to Fix the Table: Manually.  

1. Go to the table that has the merged or spilt cells.

2. Select the cell that has the merged or spilt cell in the table. Then when it is highlighted grey
right-click inside the selected cell.

3. Select the Merge Cells option.

Now the problem cell has become one fixing the Merged or Spilt Cell error. A simple table structure 
has now been created. 

3 
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Second Option to Fix the Table: Using the Accessibility Inspection Results. 

1. Go to the Accessibility Inspection Results to the right of the document.

2. Select the error Use of “Merged or Spilt Cells.” It’ll open the specific cause of the error.

3. Select the issue called “Table Cell.” It’ll make the “Recommended Actions” to appear and give
options to correct the error.

4. The only option to select for the “Merged or Split Cells” error is the “Merge Cells” option.

5. Selecting the “Merge Cells” has cause either the merged or spilt cell to become one cell. Now
it has been fixed to become a simple table structure.

Now that the Merged or Splits Cells error from the table has been fixed, this’ll cause the error to 
disappear from the Accessibility Inspection Results box. Screen readers will now easily be able to 
follow and read the information from the table. 

Fixing Accessibility Issues of Hard-to-Read Contrast 

Setting a Good Color Contrast Ratio in Document 

Text is easier to read when there is a good amount of contrast ratio between the text and page of 
the document. Good contrast is an ideal design choice for everyone and especially for those who 
have low vision. Hard-to-read text therefore lacks good contrast making the document difficult for 
people with both high and low vision to read. By follow these steps good contrast for the document 
can be accomplished: 

1. Go to the Accessibility Inspection Results box to the right of the document.

2. Select the error Hard-to-Read Text Contrast. It’ll open the specific cause/location of the error.

3. Select the issue/problem that is causing the error.

1 
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What happens after selecting issue/problem that is causing the error: The problem words or 
sentence will be highlighted in the document when it is select from the Hard-to-Read Text Contrast 
error. 

4. After selecting an issue, it’ll make the “Recommended Actions” appear and give different 
options to correct the error. By either changing the Font Color or Page Color. Most of the 
time the change will be the font color rarely is it changing the page color.  

5. Select the Font Color option and menu with different color options will appear.  
6. Theme color or More Colors can be selected to change the fonts color. 

 

 

Web AIM Contrast Checker  
WCAG AA requires a contrast ratio of at least 4.5:1 for normal text and 3:1 for large text.  

WCAG AAA requires a contrast ratio of at least 7:1 for normal text and 4.5:1 for large text. 

Web AIM Contrast Checker can help check the color contrast of a document. Using it to check the text 
color and the background against different sizes of text will show if the contrast passes the required 
ACAG of both AA and AAA or if it has failed. If it has failed changes can be made possible by changing 
and adjusting the color contrast of the document’s content to make it easier to read the information. 
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Using the Resource of a Contrast Checker 
Text is easier to read when there is a good amount of contrast against the page background. If unsure 
what would be an acceptable color for a good color contrast ratio, then changing to a darker version of 
the font color may help. For a more accurate contrast choice you can go and go and use a color contrast 
checker. 

A good resource is to use Web AIM Contrast Checker Website Resource, an online checker to be WCAG 
AA and WCAG AAA compliant from normal to large size text. 

1. Once the website has opened the Contrast Checker on the webpage can be used. 

 

1 

https://webaim.org/resources/contrastchecker/
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2. Go to the document and be in the Home Tab. 

3.  Select the words/sentences with the contrast error.  

4. Find the “Font Color” tool and select the arrow next to the tool. A drop-down menu will appear 
with color options.  

5. Select the “More Colors.”  

 
6. The “Colors” box will appear. 
7. Select the “Custom Tab.” 
8. Find where it says “Hex,” in its input box that is the hexadecimal number of the font color that is 

causing the error to the document. 

2 
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9. Copy the hexadecimal number of the font color. 

 
10. Once the hexadecimal number is copied go back to the Web AIM Contrast Checker website. 
11. In the Contrast Checker website find where it says, “Foreground Color.” 
12. In the Foreground Color where there is an input box with another hexadecimal. 

 
13. Paste the hexadecimal number that was copied from the document over it. Then press the 

“Enter” button on the keyboard. 
14. Now the color from the document will appear. 

6 

7 

8 

9 

10 

12 

https://webaim.org/resources/contrastchecker/


 Con   
15 

 
15. Check to see if the Contrast Checker passed the color of the document. Scroll down the website 

to see if it passes WCAG standards in “Normal,” “Large” and “Graphical Objects and User 
Interface Components.” If it does not go the top of the webpage, back to Foreground Color. 

 
16. Under the hexadecimal number input box there is a tool called “Lightness.” 

 
17. In the Lightness tool there is a sliding bar tool. It is to change the color that is in the hexadecimal 

input box. To make the color darker or lighter depending on where the slide tool is positioned. 
18. The hexadecimal number will change depending on the position of the slide tool. 

 
19. Once finding the desired contrast ratio color that has passed the WCAG’s standards. 
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20. Copy the new hexadecimal color from the Contrast Checker. 

 
21. Go back to the document. Then go to the Colors box to the Custom tab. If Colors box has been 

previously closed, follow steps 3 to 7 to open the Colors box. 
22. Be in the Custom tab of the Colors box. 
23. Find where it says “Hex” and paste the new hexadecimal number from the Contrast Checker. 

Then press the “Tab” button on the keyboard. 
24. To the left of the Hex input box there is a box with two colors. The top that says New is the color 

from the contrast checker pasted in, the other is the color that is currently being used and 
causing the problem for the document. 

25. Click on the OK button. 

19 
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26. Now the select words/sentence with the contrast error has changed color to the one from the 

contrast checker.  

 
27. Now there are no more Hard-to-Read Text Contrast error. The error has now disappeared from 

the Accessibility Inspection Results. 

Document No Longer has Accessibility Issues 

Document is Now ADA Compliant 
In the Accessibility Inspection Results there is now a green checkmark saying “No accessibility issues 
found. People with disabilities should not have difficulty reading this document. 

Now this Word document is compliant with all the accessibilty issues fixed 
meeting ADA standards. This document will now be accessible to everyone. 
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